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1. Guide to PicoScope 6 Automotive 
This document gives a basic overview and introduction to PicoScope 6 Automotive, 

including both the software itself and the hardware (PicoScope unit) you’ll be using. For 

more detail on any of these topics, please refer to the PicoScope 6 User’s Guide, or 

consider attending one of our training courses. 

Introduction to our equipment 
Each PicoScope automotive oscilloscope is supplied with a base set of tools and 

components, allowing you to take the voltage and current measurements you need to 

perform a wide range of tests. 

The PicoScope unit itself takes the readings from the probes and/or clamps attached and 

converts them into signals for your PC to display. It uses industry standard BNC 

connections, enabling the use of a wide variety of accessories, and is connected to the 

PC by a USB lead, which it also uses to draw power. 

At the time of writing (February 2016), our starter kits contained the following items: 

 Number 

Item 2-channel kit 4-channel kit 

PicoScope 4225 or 4425 automotive oscilloscope 1 1 

Premium test leads 2 4 

10:1 attenuator 1 1 

Flexible backpinning probe (red) 1 2 

Flexible backpinning probe (black) 1 2 

Small crocodile/gator clip (red) 1 2 

Small crocodile/gator clip (black) 1 2 

Battery clip (red) 1 1 

Battery clip (black) 1 2 

USB cable 1.8m1 1 1 

PicoScope 6 Automotive software CD-ROM 1 1 

Training resources DVD 1 1 

Automotive Quick Start Guide 1 1 

 

We also offer standard, diesel and advanced kits, with additional probes and leads and 

accessories such as current clamps and adaptors. Details can be found on our website, 

www.picoauto.com. 

Once you have connected the PicoScope to the PC, start the software. Always start the 

software after connecting the PicoScope unit: otherwise it will run in demo mode. 

The PicoScope way 
PicoScope 6 Automotive is an ever-evolving program, so it is important that the software 

installed on your PC is the latest version. 

                                           

 

1 Make sure you use the blue USB cable supplied – it has been specially designed to 

provide better grounding for your PicoScope. Please contact us if you need a 

replacement. 
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The software is designed to use as much of the PC/laptop display screen as possible to 

display the waveform being captured. 

PicoScope 6 Automotive – introducing the software 
The PicoScope 6 Automotive display is divided into three sections. The Signal View is 

highlighted in green in the image below and described in the next section of this 

document. The Toolbars are highlighted in red and discussed in Section 3, and the Menu 

bar (highlighted in blue) is covered in Sections 4 to 8. 

 

The 20:20 rule 
If you are aren’t sure which settings to use to capture your signal, a timebase of 

20 ms/div and a voltage range of ±20 V are a good start. These settings are usually 

good enough to capture a general automotive signal, allowing you to refine your settings 

from there. Timebase and voltage range will both be covered in more detail later in this 

guide. 
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2. Signal view 
The signal view is split into a fixed 10 by 10 grid. The 10 vertical divisions represent the 

voltage range, while the horizontal ones represent time. The grid is fixed but the voltage 

and time (timebase) can be varied. The oscilloscope trace is drawn from left to right 

across the signal view. 

 

 

Timebase 
The timebase is set by default to 5 milliseconds per division (ms/div), but can be varied 

in multiples of 1, 2 and 5: for example 1 s/div, 2 s/div, 5 s/div. The minimum and 

maximum timebases depend on the sampling rate of your PicoScope. Our PicoScope 

4225 and 4425 Automotive oscilloscopes have a maximum timebase of 5000 s/div. 

As the image below shows, there are lots of timebases to choose from. These can be 

accessed by scrolling up and down. 
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By default, the timebase is set as time per division, but you can change it to show the 

total collection time instead (See 8. Preferences). 

Starting and stopping capture 
The red and green buttons on the left hand side of the bottom (by default) toolbar start 

and stop the acquisition of data (this can also be done by pressing the spacebar). The 

blue highlight on either the red or the green button indicates whether or not the scope is 

capturing. The image below shows the green button highlighted, meaning the scope is 

capturing: 

 

If you prefer, you can place this toolbar at the top of the screen (See 8. Preferences). 

Triggering 
A trigger is a voltage level that, when a signal passes through it, causes the oscilloscope 

to capture or lock on to the waveform. If you don’t set a trigger, the trace may not be 

stable on the screen, and you could also miss the signal you’re looking for. 

The image below shows the trigger diamond that appears when triggering is enabled. 
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3. Main toolbars 
 

 

Number of samples 
This defines the maximum number of samples across the screen: the more samples, the 

more detailed the signal trace (and the larger the saved file becomes). The actual 

number of samples is not always exactly what is selected, but it will not be greater. 1 MS 

is a good number to use as a starting point, but this can vary depending on the test. 

Buffer navigation toolbar 
Each screen capture in PicoScope 6 Automotive is called a waveform. The software can 

store more than one waveform at a time, and the Buffer Navigation toolbar keeps a 

count of the number that have been captured. The maximum number of buffers is 

10 000. You can navigate through these buffers either by clicking on the double arrows 

to move backwards and forwards or by using the Buffer Overview, which gives a 

thumbnail view. 

 

Zooming and scrolling 
There are a number of ways to zoom into a signal and to scroll around the zoomed 

waveform. You can do this using the controls in the Zooming and Scrolling toolbar and 

the Horizontal Zoom control in the Capture Setup toolbar. 
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Window zoom 

 

This button allows you to specify an area of interest by drawing a box around it.  

  

Zoom in and out 

 

These two buttons allow you to expand a point of interest just by clicking on it, and to 

zoom out again afterwards. 

  

Horizontal zoom 

  

This allows you to zoom in the horizontal direction, subject to the capabilities of the 

device. 
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The image below shows PicoScope zoomed in 100 000 times horizontally. 

 

Zoom overview and scrolling 
When the waveform is zoomed in, the Zoom Overview window appears, showing the 

whole waveform and a box marking the area that has been zoomed in. 

 

This area can be resized by dragging the corners of the box, and moved by clicking and 

dragging within it. 

  

You can also use the hand tool to move around a zoomed-in waveform. With this 

tool selected, you can click and drag the main signal view. 
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Channel toolbar 

Channel selection 
Multiple channels can be selected. Each one is identified with a different color trace and 

matching axis: 

Channel A Blue 

Channel B Red 

Channel C Green 

Channel D Yellow 

 

Voltage range 
The voltage ranges are selectable and go up in multiples of 1, 2 and 5, e.g. ±100 mV, 

±200 mV, ±500 mV, ±1 V. While the timebase can be changed from time per division to 

the total collection time, the voltage scale is always set as the full voltage range across 

all 10 divisions, so each division on a ±20 V range represents 4 V. 
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The PicoScope 4225 and 4425 Automotive oscilloscopes have a minimum voltage range 

of ±50 mV and a maximum of ±200 V. 

 

If the yellow warning icon  appears in the upper corner of the PicoScope screen, it 

means that a difference of more than 30 V is being applied between two grounds of the 

scope. When this warning appears, you should check the orientation of the test 

connections against the wiring diagrams. In some cases, you may need to provide a 0 V 

reference to the scope, using the M4 bolt on the rear of the unit. 

If the red warning icon  appears, it means that the signal voltage is exceeding the 

normal measurement range. This icon appears in the upper corner of the screen, next to 

the relevant channel’s vertical axis: you should increase the voltage range of the channel 

displaying this error. 

Coupling 
Sets up the input circuitry of the oscilloscope. 

 

Three kinds of coupling are available: 

Coupling 

type 
Description 

AC 
Rejects frequencies below 1 Hz, useful for removing DC offset from an AC 

signal. 

DC Accepts all frequencies from DC to the scope’s maximum bandwidth. 

Frequency 
Enables the built-in frequency counter, only available on some 4000 series 

Automotive oscilloscopes. 
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Lowpass filtering 
Lowpass filtering is useful for eliminating noise from a signal. It does this by rejecting 

the high frequency data from any selected input channel. The filtering control is found in 

the Channel Options menu, which you can access by clicking the Channel Options 

button  for the relevant channel. This control determines the cut-off frequency of the 

filter, which must be less than half the sampling rate (shown on the Properties sheet, 

which can be accessed from the Views menu or by right-clicking on the signal view. You 

will find more information about this in the PicoScope 6 User’s Guide). 
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The split screenshot below shows the effect of applying a 1 kHz lowpass filter on a noisy 

signal. The underlying shape of the signal is preserved, but the high-frequency noise is 

eliminated: 

 
Left: before lowpass filtering. Right: after 1 kHz lowpass filtering. 

ConnectDetect® 
A new feature, only available on the PicoScope 4225 and 4425 automotive scopes, is 

ConnectDetect, a simple way to make sure your test probes are correctly attached to the 

components under test. To start using it, click the ConnectDetect button  in 

PicoScope 6 Automotive. 

Every channel input on your PicoScope has an LED next to it. When ConnectDetect is 

activated, each channel’s LED is either green, to indicate that the test probe is directly 

connected across a component, or red to indicate that it is not. 

An icon representing the LED is also shown on the PicoScope screen, as in the example 

below, where ConnectDetect has been activated on all four channels, but only Channels 

A and B are properly connected. 
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Note that ConnectDetect only works when you use probes that come into direct contact 

with the component under test. Sensors such as the TA204 coil-on-plug and signal 

probe, which works using electrical induction from the ignition coils attached to the spark 

plugs, do not make such a connection, so ConnectDetect will not work on them. 

Triggering toolbar 
You can use the Triggering toolbar to make five key adjustments to the triggers. 

 

 

 

Trigger mode 

 

None: No trigger condition is set and PicoScope acquires waveforms repeatedly 

without waiting for a signal to trigger on. 

Auto: PicoScope waits for a trigger event before capturing the data. If, however, no 

trigger event occurs within a reasonable time, it captures the data anyway 

and it will keep on doing so until the capture is manually stopped. 

Repeat: PicoScope waits indefinitely for a trigger event before capturing the data and 

will keep on doing so until the capture is manually stopped. If the trigger 

event never occurs, no data will be displayed. 

Single: PicoScope waits for a trigger event before capturing the data and then once it 

acquires the waveform it stops capturing. 



Pico Technology  PicoScope 6 Automotive Introductory Guide 

 

13  

 

 

Trigger source 
This option defines where the trigger will come from, and varies between models. One 

thing that is common across all our products is that their input data channels can be 

used as triggers. 

 

Rising/falling edge trigger 
 

These buttons control which side of the waveform you set the trigger on. For example, if 

you set a 1 V rising edge trigger, your PicoScope will only capture data if the signal 

increases from below 1 V to above 1 V. 

 

 

 

 

 

 

 

Trigger threshold 

 

Use this box (highlighted in yellow above) to set the voltage of your trigger. In the 

rising/falling example above, the trigger threshold was set to 1 V. 

Pre-trigger  
This is a very useful adjustment as it allows you to control how much you see of what 

happened before the trigger event. The images below show an injector voltage on a 

500 µs/div timebase, giving a total of 5 ms across the screen. Figure 1 shows a 20% 

pre-trigger, with 1 ms of data before the trigger event. Looking at the signal, you cannot 

Rising Edge Trigger: Signal 

moves from below to above 

the trigger diamond 

 

Falling Edge Trigger: Signal 

moves from above to below 

the trigger diamond 
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see what happened to the waveform before this. Figure 2 shows a 50% pre-trigger, with 

2.5 ms before the trigger event, which makes it much clearer what the signal does. 

 
Figure 1 

 
Figure 2 
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4. The Automotive menu 
The Automotive menu is at the heart of PicoScope 6 Automotive, with over 150 pre-set 

tests that can be performed on vehicles. 

 

The Show Web Help option at the bottom of the Automotive menu disables and enables 

guided tests. These are pages on the picoauto.com website, with full instructions for 

carrying out the test, along with some background information. This option affects all the 

pre-set tests, so if you clear the check box, the web pages will not appear. Web help is 

enabled by default. 

 

 

An example waveform within the web help (guided test) topic shows how the signal 

should appear (the signal you see in PicoScope when you run the test will vary from one 

vehicle to the next). This will contain all the relevant settings to carry out the test, 

including correct timebase, voltage range, custom probe and triggering. 
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The waveform and settings also open in PicoScope 6 Automotive, whether web help is 

enabled or not. You may need to adjust these settings, as every vehicle is different, but 

they give a good starting point. 

 

The guided test web help also provides notes on the waveform, to explain the detail of 

the signal. Below these, you will find technical information on the test in question. 

 

You can then start the test, using the red and green Start and Stop buttons.  
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5. Measurements 
Measurements can be achieved using either rulers or automatic measurements. 

Basic rulers 
The image below shows the voltage ruler handles and the time ruler handle. The voltage 

ruler handles are the same color as the channel they are associated with, while the time 

ruler handle is white. 

 

There are two rulers for time and two rulers per channel for voltage. The rulers can be 

used by moving the mouse over the ruler handles and dragging. You can move the time 

rulers left and right, and the voltage rulers up and down, at any time. 

As soon as you start to move the first ruler, the ruler legend box appears, showing the 

ruler’s exact position on the time or voltage scale. When you drag the second ruler into 
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place, its position is added to the ruler legend box and the difference between the two 

values (∆, delta) is displayed. 

 

Rotation rulers 
The rotation rulers help to measure the timing of a cyclic waveform on a scope view. 

Instead of measuring relative to the trigger point, as time rulers do, rotation rulers 

measure relative to the start and end of a time interval that you specify. Measurements 

may be shown in degrees, percent or a custom unit as selected by the Ruler settings 

box. 

To use the rotation rulers, drag the two rotation ruler handles onto the waveform from 

their inactive position as shown below: 
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In the signal view below, the two rotation rulers have been dragged into place to mark 

the start and end of a cycle. The default start and end rotation values of 0° and 720° are 

shown below the rulers and can be edited to any custom value. 

 

Notice that, as well as the 0° and 720° markers, lines have been drawn to mark 180°, 

360° and 540°. These were inserted using the Rotation Partition option in the Ruler 

settings box, which appears when you click Rulers on the bottom toolbar. 

 

Ruler legend 
The rotation rulers become more powerful when used in conjunction with time rulers. 

When both types of rulers are used together, as shown in the image below, the ruler 

legend displays the positions of the time rulers in rotation units as well as in time units. 

If two time rulers are positioned, the legend also shows the rotation difference between 

them. 
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Closing the ruler legend dismisses all rulers, including the rotation rulers. 

Automatic measurements 
These can be added in three different ways: from the Measurements menu, by right-

clicking on the screen, or using the Measurements toolbar at the bottom. 

 

Whichever method is used, the Add Measurements window appears. 
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Select the channel you want to take the measurements on by clicking on the first pull-

down menu. Then choose the type of measurement. Finally, choose which section of the 

graph you want to take the measurements from: this could be across the whole trace, 

between two rulers or the cycle around one of the rulers. 

The measurements appear at the bottom of the screen. By default, the statistics are 

taken from the previous 20 captures (see 8. Preferences for how to adjust this). 

 

You can also adjust the font size by going into the Measurements menu and selecting 

Grid Font Size: 
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6. File menu 
You can access the File menu from the menu bar. It allows you to open and view saved 

files, view recent files, change start-up settings and print. 

 

 

Save 
This allows you to save the current waveform, all the waveforms in the buffer or a selection 

of waveforms from the buffer. 

Save As 
This allows you to save the current waveform, all the waveforms in the buffer or a 

selection of waveforms from the buffer as a new file. 

The following table shows a list of file formats that can be saved or opened in 

PicoScope 6: 

Format Description 

psdata PicoScope 6 format contains full waveform data and settings 

pssettings PicoScope 6 format contains settings 

csv Stores up to 1 million samples 

txt Stores up to 1 million samples 

bmp Image format 

png Image format 

gif Image format 

Animated 
gif 

Image format over a number of waveforms, showing an animation of all the 
waveforms in a continuous loop (only available when saving all waveforms) 

MATLAB MATLAB 4 .mat binary format: an open format with no limitation on the number of 
samples. 

jpg Image format 

pdf PDF format. Output file contains a snapshot of the waveform, with no borders. 
 

The psdata format is the PicoScope data format, which saves an exact copy of the 

waveform. Saving in this format also saves the settings, such as voltage range, timebase 

and triggering, along with any notes that have been made. The pssettings format just 

saves the settings and not the waveform, which can be useful as the files allow multiple 

settings to be saved for different tests and are often much smaller in size. 

A key feature of PicoScope 6 Automotive is that the software is free and can be 

downloaded by anyone – with or without a PicoScope oscilloscope. Thus, anyone can 

view saved waveforms in the same detail they were captured in. 
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PicoScope 6 Automotive allows you to save vehicle and customer information alongside 

your waveform. You can choose not to enter this information by leaving the form blank, 

but it is useful reference data, particularly if you choose to upload the file to the online 

Waveform Library. 

   

 

Waveform Library Browser 
If you use a PicoScope Automotive oscilloscope, then you have access to an ever-

increasing collection of user-generated waveforms through our online Waveform Library. 

You can use this to share your own examples of good and bad waveforms or to browse 

the waveforms other people have shared. You can also use it as an online backup for 

your waveform files. 

To log in to the waveform library, make sure your PicoScope is connected to the 

computer, then click on File > Waveform Library Browser. Your login details will be 

the same as those you use on the Pico Technology Automotive Forum – if you don’t have 
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an account there, you can register for free via the link on the Waveform Library login 

page. 

 

Startup Settings 
The startup settings can be changed from the File menu: 

 

Selecting Save Settings As stores all the current settings in pssettings format, allowing 

you to create a library of different setups. 

Selecting Save User Default Settings saves the current settings as the default and 

also assigns them to the Home button . Reset Startup Settings loads the factory 

default settings. You can revert to the original factory settings by selecting Reset User 

Default Settings. 

Print and Print Preview 
Use the Print and Print Preview options to print a paper copy of your waveform and to 

check how it will look on the page beforehand. 
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Recent Files 
This shows a list of the most recently viewed waveforms, which appear as thumbnails for 

quick and easy viewing. 
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7. Edit menu 
The Edit menu is located on the menu bar: 

 

Copy as Image 
This allows you to copy just the signal view, excluding measurements and the ruler 

legend box. 

 

Copy as Text 
This copies the raw data in text format and can copy up to 1 million samples per 

channel, which you can then paste into a spreadsheet. 
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Copy Entire Window as Image 
This copies the entire PicoScope 6 window, including everything you can see. 

 

Notes 
A Notes box is added at the bottom of the page. It is visible when printed and is 

preserved when the file is saved. 
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8. Preferences 
The Preferences allow you to set options for the PicoScope software. You can do this 

from the Tools menu, by selecting Preferences. 

 

The Preferences options are split into tabs: 

 

General  
The Reset Preferences button deletes any changes you have made and returns the 

preferences to the factory settings. 

 

Waveform Buffer 
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By default, the waveform buffer is set to 32, but you can change this to any number 

between 1 and 10 000. The actual number of waveforms may vary due to a number of 

factors: the device that is being used, whether the device is in block or streaming mode, 

the number of samples per waveform and the type of triggering used. 

Collection Time Units 
By default, the timebase of the scope is given in seconds per division. The total collection 

time, on the other hand, represents the time across all ten divisions of the screen. For 

example, a 10 ms/div timebase is equivalent to a total collection time of 100 ms. 

 

    

Measurement Statistics 

 

When you make an automatic measurement, PicoScope 6 Automotive presents statistics 

recorded over a number of captures. This section of the Preferences allows you to control 

the number of captures you use. By default, it is set to 20, but you can increase it to 

1000. 
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 Power Management 

 

This control limits the speed at which PicoScope captures data from the scope. The other 

PicoScope settings, the type of scope and the speed of the computer will all affect 

whether this limit can actually be reached. PicoScope automatically selects the 

appropriate limit according to whether the computer is running on batteries or on mains 

(line) power. 

The capture rate is in captures per second. By default, it is set to 30 Captures per 

second. If other applications run too slowly on the PC whilst PicoScope is capturing, 

reduce the capture rate limit. When the computer is running on battery power, 

PicoScope imposes a performance limit to save the battery. You can increase this 

manually, but doing so will cause the battery power to drain very quickly. 
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Sampling 

Slow Sampling Transition 
The oscilloscope has two modes of operation: block mode and streaming mode. In block 

mode, the device captures data to its own internal memory and then transfers it to the 

PC, so the trace appears on the screen once the buffer is complete. In streaming mode, 

the device continuously streams data to the PC, so the trace is drawn in real time.  

The Slow Sampling Transition control alters the timebase at which the device changes 

from block mode to streaming mode. You can choose from a number of different 

timebases, between 100 ms/div and 500 s/div. By default, it is set to 200 ms/div.  
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Slow Sampling Display 
This displays the previous buffer as the new one is being drawn. The image below gives 

a clearer view of this. 

 

Colors 
Under this tab, you can change the colors of the traces, background, masks and a 

number of other aspects of the display. You can also adjust the line thickness of the 

traces and the grid. 
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Keyboard shortcuts 
PicoScope 6 Automotive allows the use of shortcuts to the vast majority of its features. 

These can be accessed from the Keyboard tab of the Preferences. 

 

Highlighting an action allows you to enter the desired shortcut keys. You can use up to 

four keys for one shortcut, including up to three modifiers (Ctrl, Alt and Shift). Clicking 

the Assign button confirms entry, and upon clicking OK the new shortcut keys are ready 

to use. 

Regional & Language  
In this section, you can change the language of the software and select metric or U.S. 

units. This can be done easily by selecting the language or units and then clicking OK. 
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You will then be prompted to restart the software. Clicking Yes will automatically exit 

the software and then start it up again in the language and units you selected. 

Options 
The Advanced features settings allow you to enable various features, adding buttons 

controlling them to the relevant toolbars. You can also choose whether the Trigger 

toolbar (Start/Stop etc.), which appears at the bottom of the waveform screen by 

default, appears at the top. 

 

 

Recent files refers to the list of files that have been opened that is shown in the File 

menu. You can modify this list to show up to 32 items.  
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Printing 
When you print a waveform, some default text appears at the top and bottom of the 

page. You can modify this by editing the appropriate fields in this tab, and can view the 

results by opening a print preview. 

 

Updates 
While you can check for software updates at any time, you may prefer to set up 

automatic updates, to make sure you always have the most up-to-date version of 

PicoScope 6 Automotive. This menu also gives you the option to stay informed of 

software released under beta testing. 
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9. Help menu  
The Help menu can be accessed from the menu bar: 

 

User’s Guide opens the help file: 

 

Online Documentation is a link to Pico Technology’s library of automotive case studies, 

training, videos and tutorials, whilst Online Forums connects you to our support forum. 

Send Feedback opens a dialog to send us your comments on PicoScope 6 Automotive 

from within the software. 

Check for Updates 
If a web connection is active, you can check the latest version of the software and install 

it if necessary. Alternatively, you can set up automatic updates (see 8. Preferences). 
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About PicoScope 6 Automotive 
This contains information about the software version you are using, and also information 

read from the scope. 
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